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GETTING STARTED SYSTEM REQUIREMENTS

GETTING STARTED

Welcome to Crimson 3—the latest version of Red Lion’s widely-acclaimed operator interface
configuration software. If you have used an earlier version of Crimson, you will soon notice
that Crimson 3 provides a huge number of improvements—while retaining all of the power
that you have grown used to. If you are new to Crimson, be sure to read at least the first few
chapters of this manual to get an introduction to how the software works. Either way, you will
soon find out how Crimson 3 makes it easier and quicker for you to design powerful and
attractive operator interface solutions.

SYSTEM REQUIREMENTS

Crimson 3 is designed to run on any version of Microsoft Windows from Windows 7
onwards. Memory requirements are modest, and any system that meets the minimum system
requirements for its operating system will be capable of running Crimson without any
problems. About 150MB of free disk space will be needed for installation, and you should
ideally have a display with sufficient resolution to allow the editing of display pages without
having to scroll too much. For a VGA target device, an XGVA PC is recommended.

INSTALLING THE SOFTWARE

Crimson 3 is supplied as a Microsoft Installer package or an msi file. You will typically have
downloaded this file from Red Lion’s website, but if you have downloaded it from another
source, please check that Windows is satisfied with the package’s digital signature so that you
are assured of receiving genuine Red Lion software...

Internet Explorer - Security Warning

Do you want to run this software?
ﬁ Name: Crimson 3.0 Installer
Publisher: Red Lion Controls Inc

More options Run ] [ DortRun |

‘wihile Files Fram the Internet can be useful, this File bvpe can potentially harm
wour computer, Cnly run softweare From publishers wou trust, What's the risk?

As shown above, the publisher should show as Red Lion Controls Inc, and you should be able
to click on the publisher’s name to verify the integrity of the digital signature. Once you are
happy with the package, press the Run button to start the installation.

The installation process is fairly standard, and ought to proceed without much interaction
beyond your specifying the target directory. Once the process complete, look at your Start
Menu and find the Red Lion Controls folder. Click the Crimson 3 icon to start the software.

REVISION 1.0 PAGE 1
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REGISTRATION

When you first run Crimson 3, you will be offered a chance to register your software...

Register Your Copy of Crimson 3

Details

Name: ‘ Eob Erikson

Email: ‘ bobe@redion.net

Company: ‘ Red Lion Controls

Strest: [20 wilow Springs Circle

City: ‘ “ork.

State: [Pa

ZIP: 17406

Country: UMITED STATES i

Product 10: ‘76487-OEM-DD1 1903-00102

Send me data on Crimson 3 updates.
Send me data on Red Lion products.

Status

Callecting user information.

hip

While registration is optional, we strongly recommend that you take the opportunity to
provide us with your contact details so that we can inform you of Crimson updates and of
associated products. Since registration requires an Internet connection, you may skip the
process if so do not have such a connection available. Crimson will periodically remind you if
you are running an unregistered copy of the software.

CHECKING FOR UPDATES

If you have an Internet connection, you can use the Check for Update command in the Help
menu to scan Red Lion’s web site for a new version of Crimson 3. If a later version than the
one you are using is found, Crimson will ask if it should download the upgrade and update
your software automatically. You may also manually download the upgrade from Red Lion’s
website by visiting the Downloads page within the Support section.

INSTALLING THE USB DRIVERS

If you’ve followed the instructions that came with your target hardware, you will not yet have
connected the hardware to your PC. Now that you have completed the Crimson 3 installation
(USB driver included), you may safely connect the device using a standard USB cable with
USB-B connector. After some churning, Windows should indicate that it has found the
drivers for the new hardware and that it is ready for operation. No further user intervention
should be required. Go to Link-->Options to access the Link Options window. Select the USB
radio button to communicate to the module via USB, which automatically finds the E3
device. To use this method only one E3 module should be connected to the computer at a
time. The E3 modules communicate with Crimson via a virtual serial com driver.

PAGE 2
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TROUBLESHOOTING

TROUBLESHOOTING

If there are more than one device connected to the computer it is possible that crimson may

not find the correct device. Go to Windows device manager (type ‘device manager’ in the
search bar on the Start button) to determine the COM port number of the device. Go to Link--
>Options window to select the COM radio button entering port number assigned by windows.
The E3 intelligent I/O should be listed under Ports (COM&LPT) as a Dual Ethernet 1/O
Module.

%

=5 Device Manager
File  Action  View Help

&= 7 HEl®

4 =y BL-SUPLAB-006
» M Computer
b= Disk drives
b By Display adapters
b \:.,. DD ACD-ROM drives
> g IDE ATAFATAPI controllers
b ¥ Metwork adapters
.| Partable Devices
T Ports (COM & LPT)

4

> -#y Sound, video and game controllers

o

Link Options
Communications Part
TCRIP
1 LSE
& COM
(8] 4 ][ Cancel ]

If you connected the target device to your PC before installing Crimson 3.0, it is possible that
an aborted installation has made it impossible for you to install the drivers correctly. To check
for this, open the Windows Device Manager by finding the My Computer icon, right-clicking
and selecting the Manage command. A window similar to the one below should appear...

REVISION 1.0
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=1 Device Manager
File Action ‘fiew Help
= @ HE

4 BL-SUPLAB-006
.M Computer

\J Disk drives

- B Display adapters

> i) DVD/CD-ROM drives

L IDE ATASATARL contrallers

AI--I" Metwark adapters

2 Intel(R) 82579LM Gigabit Metwark Connection
5 Microsaft Teredo Tunneling Adapter

S Realtek RTLB139/810x Family Fast Ethernet MIC
Ethernet Adapter

Other dewvices
7 Unknown device

a7 Ports (COM & LPT)
S5 Communications Port (COMI)
. 2} Processors

b -1y Sound, video and game controllers
1M System devices

b ¢ Universal Serial Bus controllers

The exact process for getting to this point will vary from one operating system to another, but
the basic idea is the same: Find the My Computer icon—either on the desktop or on your start
menu—right-click it and select Manage. If that doesn’t work, select the System option from
the Control Panel, and activate the Device Manager from the Hardware tab.

If you have a problem with your USB drivers, you will see a yellow icon carrying an
exclamation point under the Other Devices category. The name of the icon may be unknown
device or Loader or something similar.

To fix the problem, right-click on the broken device and select Uninstall from the menu...

After asking for confirmation, Windows will remove the device from your system. You can
now power the Crimson target device off. After a couple of seconds, reapply power and
Windows will start the driver installation process once again.

GETTING ASSISTANCE

If you hit a problem or need assistance, several resources are available.

BALLOON HELP

Crimson contains a very useful feature called Balloon Help...

Data Format

Mumber Base:

Sign Maode: Soft Sign hd

Digits Before DP: e Dinits Afber OO: 1] 73]
Lead Chararter; | Mumber Base
Indicate the number base to be used for displaying this tag.

This facility allows you to see help information for each item within Crimson. It is controlled
via the icon at the right-hand edge of the toolbar or via options on the Help menu. The default
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mode allows the help text to be displayed by pressing the F1 key, providing a quick way of
getting information if you are unsure of the settings for a given field. Keep this in mind, and
your life will be a lot easier!

TECHNICAL SUPPORT
Technical assistance is available on the web at...

http://www.redlion.net/support.html

Or, we can be contacted via email at...

support@redlion.net

You may also call +1 (717) 767-6511 and ask for the HMI Support Team.

ONLINE FORUMS

A number of online forums exist to support users of PLCs, HMIs, RTUs and I/O Modules.
Red Lion recommends the Q&A forum at http://www.plctalk.net/qganda/. The discussion
board is populated by many experts who are willing to help, and Red Lion’s own technical

support staff also keep an eye out for questions relating to our products.

THE NEXT STEPS

We suggest that existing Crimson users at least give the next chapter a cursory reading. If you
are completely new to Crimson, please try to read at least as far as the start of the chapter on
I/O Channels.

Good luck, and have fun!
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CRIMSON BasICs WINDOW LAYOUT

CRIMSON BASICS

To run Crimson, select the Crimson 3 icon in the Red Lion Controls section of your Start
Menu. After a couple of seconds, Crimson will appear. The first thing you will notice is the
user interface that we have adopted. This new interface allows quicker navigation and faster
database construction. We hope that it will greatly improve your productivity.

WINDOW LAYOUT

The main Crimson window comprises three sections...

-¢- Untitled File - E3-MDC24880 - Crimson 2.0 =lal=s
> 0 @HJJ%E;@Z&A@ a.
- — x
B X Ethernet 1 |Ethemet 2 | Download | Options B Devices
B Communics tions ress Assignmen
=Y Netwark CEAIEn ey *
S sicnet UDR Part Made: ion
& 88 g
49 Watchdog/Heartheat
38 Web Server Default Gateway:
Resource
S Editing Pane Pane
Navigation g
B Conmunicatons
5 yo crannes
Security Manager ﬁj Devices

THE NAVIGATION PANE

The left-hand portion of the window is called the Navigation Pane. It is used to move between
different categories of items within a Crimson configuration file. Each category is represented
by a bar at the base of the pane, and clicking on that bar will navigate to that section. The top
section of the Navigation Pane shows the available items in the current category, and provides
a toolbar to allow those items to be manipulated. If you want to make the top section larger,
you can pick up and drag the dividing line between it and the category bars.

THE RESOURCE PANE

The right-hand portion of the window is called the Resource Pane. It is used to access various
items that are of use when editing the current category. Just like the Navigation Pane, it
contains the device category which can be accessed via the category bar. This displays a list

of devices that are connected to the E3 module via I/O transfers designed data from to and
from the E3 module.

REVISION 1.0
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THE EDITING PANE

The central portion of the window is used to edit the currently selected item. Depending on
the selection, it may contain a number of tabs, each showing a given set of the properties for
that item, or it may contain an editor specific to the item that you are working on.

COLLAPSING PANES

Either or both of the Navigation Pane and Resource Pane can be collapsed to the edge of the
main window in order to free-up more space for the Editing Pane. To close a pane, click on
the ‘x’ in the top left-hand corner of its title bar. It will then be replaced by a smaller bar
marked with arrows. Clicking this bar will expand the associated pane. Clicking on the
pushpin icon of a temporarily-expanded pane will lock it in place.

THE CATEGORIES

The main categories in a Crimson E3 database are as follows...

COMMUNICATIONS

This category specifies which protocols are to be used on the target device’s
E serial port and Ethernet ports. Two slave protocols are supported on devices

Ethernet ports by default Modbus TCP/IP and UDP/IP and Sixnet UDR TCP/IP
UDP/IP. Two Master protocols are supported by the E3 module Modbus UDP/IP
and Sixnet UDP/IP (i.e. protocols in which the Red Lion hardware initiates data
transfer to and from a remote device). You can also use this icon to specify one or more
devices to be accessed. Where slave protocols are used (i.e. protocols in which the Red Lion
hardware receives and responds to requests from other systems) all data items are exposed for
read or write access automatically no configuration is required. Essentials services like
watchdog, heartbeat signals and enabling the web server are included here as well.

I/0 CHANNELS

This category shows a definition of all the I/O channels available on the module

'-E3 whether physical or virtual. It is also used to configure features specific to the

* physical I/O channels on the module. Only the configurations specific to the

module you are configuring will be available. Press the /O Channels category

and sub-categories will appear in the navigation pane. For Example, discrete input channel

configuration screens will appear if you are configuring a E3-32DI24-1 (discrete input
module).

SECURITY MANAGER

This category is used to manage permissions on the web server. You may create
and manage the various users of the target device, as well as the access rights
granted to each. Real names may also be given, which grants or restricts system

rights from users. These rights are only useful in the web server.

PAGE 8
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GETTING AROUND

The easiest way to get around a Crimson database is to click on the category bars in the
Navigation Pane, and then click on the item you want to edit. However, a number of shortcuts
exist to allow quicker movement and thus greater productivity. Most of these shortcuts can be
accessed via the Go menu, or via associated key combinations. ..

{3 Back Alt+Left
5 Communications Ctrl+1
*2 0 Channels Ctrl+ 2
QB Security Manager Chrl+ 3

Mext Categaomy A+ PgDn

BACK AND FORWARD

The first icon on the toolbar or the ALT+LEFT key combination can be used to move back to
items that you had previously selected. The next icon or the ALT+R16HT key combination can
then be used to move forward again, returning to the item you first started with. This facility
is very useful when switching between database categories.

CATEGORY SHORTCUTS

Each category is allocated a shortcut key sequence, comprising the CtrL key and a number
indicating the category’s position in the Navigation Pane. For example, the Communications
section can be accessed directly by using the CTRL+1 combination. You can also move up and
down in the category list by using the ALT+PeUp and ALT+PeDN key combinations.

ITEM SHORTCUTS

If you are working in the Editing Pane, you can switch between items by using the ALT+Up and
ALT+Down key combinations. Crimson will move to the previous or next item in the item list,
and will try to keep the currently-selected data field the same. This is very useful if you want
to change the same field on a number of items, as you do not have to keep navigating back to
that field or switching to the Navigation Pane in order to change items.

REVISION 1.0 PAGE 9
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NAVIGATION LISTS

Several categories in Crimson contain lists of items. For example, selecting the I/O Channels
category will cause the Navigation Pane to show a list of all the I/O Channels screens
available in your database, allowing them to be selected and edited...

& Untitled File - E3-MDQ4880 - Crirnsan 3.0 (=% ECR (57

File Edit Yiew Go Link Help

GO G e o [ o oA M-
Havigation Pane X, | System - [0 Channels (4] Resource Pane bd
e * | B Dewices

Physical I0 Channels

/0 Channels i
t‘ Discrete Input Channels IS e

*_, Discrete Output Channels Discrete Qutput i
*, 2nalog Input Channels

m

Analog Input Channels : 8

Discrete Inputs
1-24  : DiscreteInputs
25-32  : FreeInternal Registers
33  Self Test OK Read Only)
34 : Power 1 0K [Read Onlyl

35 © Power 2 OK [Read Onl
?&I Communications L W
36 | O Status [Read Only)
E3
".. {0 Channels 37 + Link Status 1 [Read Only)
Security Manager 33  Link Status 2 [Read Only) i -EF‘!SI Devices

Items within these Navigation Lists can be manipulated in various ways...

To quickly find an item, type the first few letters of its name. Crimson will select the
first item that matches the characters you have entered. Typing more characters
will make the selection more specific, while pressing Esc will allow a new
sequence of search characters to be entered.

To create an item, click on the New button in the Navigation Pane toolbar. For those
lists that support only a single type of item. The New button on the toolbar may
offer a list of available items, allowing you to choose the type of the item you
wish to create.

To delete an item use the Delete icon in the Navigation Pane toolbar. Warnings are
provided for multiple deletes, although they can always be reversed via the Undo
command.

To rename an item, select it and press F2. You may then enter the new name and
press ENTER. Alternatively, select the item and then single-click on the name once
more to activate editing. Again, press ENTER when you are finished.

UNDO AND REDO

Crimson 3 implements a universal undo and redo structure. This means that you can load a
database, edit it for hours, and then return it to its original state by simply holding down the
CTrL+Z key combination. You can then re-apply your changes by holding down CtrL+Y. All
your actions are remembered, and Crimson will navigate between items and categories
automatically when reversing or re-implementing changes.

PAGE 10 http://www.redlion.net/e3
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WORKING WITH DATABASES

Crimson stores all the information about a particular configuration in what is called a
database file. These files have the extension of cd3, although Windows Explorer will hide
this extension if it is left in its default configuration. While Crimson 3 databases are still
essentially text files, they are compressed and therefore cannot be directly edited using a text
editor like Notepad. As you would expect, databases are manipulated via the commands
found on the File menu. Most of these commands are standard for all Windows applications,
and need no further explanation.

DATABASE PROTECTION

Databases can be password-protected using the Protection command on the File menu...

Database Protection

Setkings

Defaul Access:
Enter Password:

Repeat Password:

Recovery Email: test@redlion.net

The Default Access parameter is used to define what level of access will be permitted without
first entering the database password. A setting of Read-Only Access will allow the database
to be opened, but will not allow changes to be made or saved. A setting of No Access will
prevent all access without the password. The default setting of Full Access will allow the
database to be opened for editing without any password being entered. Lost passwords can be
recovered by Red Lion Controls for free, or for a nominal fee if you make a habit of it! Note
that for security reasons, the recovered password will only ever be sent to the Recovery Email
configured in the protection dialog box. Be sure to set this to a valid email address.

DOWNLOADING TO A DEVICE

Crimson database files are downloaded to the target device by means of the Link menu.

CONFIGURING THE LINK

The programming link between the PC and the target device can be made using a USB port or
a TCP/IP connection. Before downloading, use the Link-Options command to ensure that you
have the correct method selected. ..
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Link Options @

Cammunications Port

TCRAP
@ LB
Ok ] | Cancel |

When using the USB radio button to perform the configuration download Crimson will
automatically find the COM port associated with the device. Only one E3 device may be
connected to the PC when using this method.

To download over TCP/IP select the TCP/IP radio button. Note that this dialog does not
provide any method to select the target IP address when using TCP/IP for download. This
information is stored in the database file and is configured via the Download tab of the
Network configuration item. This method makes it easier to switch between multiple
databases without having to re-configure the target IP every time.

Select the COM radio button if the USB auto-detect does not work. To find the COM driver
number that windows assigned to the E3 device go to windows device manager. The E3
intelligent I/O should be listed under Ports (COM&LPT) as a Dual Ethernet /O Module.

SENDING THE DATABASE

Once the link is configured, the database can be downloaded using either the Link-Send or
Link-Update commands. The former will send the entire database, whether or not individual
objects within the file have changed. The latter will only send changes, and will typically take
a much shorter period of time to complete. The Update command is typically the only one
that you will need, as Crimson will automatically fall back to a complete send if the
incremental download fails for any reason. As a shortcut, you can access Link-Update via the
lightning bolt symbol on the toolbar, or via the F9 key on the keyboard.

Download Database via USB

Status

Clearing configuration data.

The E3 device’s unique 7-digit serial number is used identify that you are connected to the
correct module. This number may be found on the front of the E3 I/O module as a
“configuration serial #”. We recommend you enter this number into your database in the
communications window. The serial follows the configuration door, so if the door is
transported to another E3 device of the same type that E3 device will have that serial number.
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1 =& Untitled File - E3-MDC20884 - Crirnson 3.0 - UNREGISTERED COPY
File Edit Aiew Go Link Help

ENSN RN NN TS Ne RETNEEN SN s K Fei [
— E ‘ System - C ications

General Settings

T sbet UDR Station Number:
S Modbus
RS-485 Comms Port TD and RD display LEDs: [AnyfAll Ports -
= B services

il Wieb Server
Transfer Settings

10 Transfer Scan Rate: 1000 = ms
Ethernet Request Timeout: | 1000 =]
Serial Request Timeout: 3000 = ms

If the serial number in the database doesn’t match the serial number in the E3 device Crimson
will display a message with the serial number it found. Verify you are connected to the
correct module and click yes or no depending on how you would like to proceed.

Crimsan 3.0 23 |

Target device serial number [S100124) does not match the value configured
inthe database.

Do you want to continue with this operation?

VERIFYING THE DATABASE

To check whether the database matches what is loaded in the E3 device you are connected to
use the Link-->Verify... command. When selected the crimson will go through every
configuration option loaded in the device verify it matches with what is in the saved database
on your computer.

Werify Database via Serial @

Status

DOME - The device matches the currently loaded database,

Close

Crimson 3.0 @

The database in the target device does not match the currently
loaded configuration,

Do you want to update the unitwith the current database?

es ] [ Mo
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EXTRACTING DATABASES

The Link-->Support Upload command can be used to instruct Crimson as to whether or not it
should include the information necessary to support database upload when sending a database
to a target device. This setting is stored in the database, and can thus be configured on a per-
file basis.

Note that if you lose your database file and you do not have upload support enabled, you will
not be able to reconstruct your file without starting from scratch. To extract a database from a
panel, use the Link-->Extract command. This command will upload the database, and prompt
you for a name under which to save the file. The file will then be opened for editing. If the
database was password-protected, you may be required to enter the password before if can be
opened. In other words, enabling upload will not circumvent password protection.

E3 I/0 MODULE

& test1234 - E3-16DORLY - Crimsan 3.0 - UNREGISTERED COPY =nEol =)
Eile Edit %iew Go Link Help
A .
NS N5 S e TR [N = e @3-
iazlgetion Fane X, | System - Communications T T —
) X ] B Devices
General Settings
; Communications
= T Mebwork Station Name: MewStation
? sixnet UDR Station Number; 1 =
T Modbus
R3-435 Comms Port TD and RD display LEDs: | Any/sll Ports -
= Services !
G wiatchdog/Heartbeat Serial Mumber:
o3l Web Server
Transfer Settings
10 Transfer Scan Rate: 1nan = ms
Ethernet Request Timeout: | 1000 = ms
Serial Request Timeout: L] = ms
EFI Communications
«E /O Channels
Security Manager Gl%l Devices

MUk

In this window you will set parameters that apply globally to the specific device being configured.

General Settings

In the Station Name field, the /O module may be assigned a unique station name.
The name may be up to 20 characters in length and may contain letters, digits
and underscores.
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In the Station Number field, enter a value for this module. Each module may be
assigned a station number in the range of 0 to 15,999 when using Sixnet UDR
protocol, and 1 to 247 when using Modbus protocol.

TD and RD Display LEDs—The TD (transmit data) and RD (receive data) LEDs
flash to indicate activity on a communications port. They may be assigned to the
USB port, the RS-485 port, or both.

In the Serial Number field, enter the value for the module being configured. The
serial number is in the device’s memory as well as printed on the label. The
serial follows the configuration door, so if the door is transported to another
module of the same type that device will have that serial number.

Transfer Settings

An I/O Transfer is a way of copying input or output values from one E3 device to
another (or Modbus device). The station that is performing the transfer is
designated as the "Local Station". I/O values can be transferred to or from an
external device (I/O module or RTU/PLC). When I/O transfers are configured
the E3 I/O module is the master device. On Ethernet the E3 /O module can be
both master and slave.

A station can have up to 32 I/O transfers configured at one time. The transfers are
executed in the order they are listed, from top to bottom. When a transfer
completes, a status bit may be set or cleared to indicate success or failure.

In the /O Transfer Scan Rate field define the time interval between queries from the
E3 to the remote device. The transfer rate is used for serial and Ethernet
transfers. The minimum IO transfer scan rate is 1000ms and the maximum is
255000ms.

In the Ethernet Request Timeout field define the amount of time you would like the
E3 I/O module to wait for a response from the before it moves to the next
transfer in the list. The minimum Ethernet request timeout is 100ms and the
maximum is 255000ms. Some devices take longer to respond than others, so this
value may have to be adjusted depending on the device. If a response is not
received before the Ethernet request timeout expires the status bit associated
with the I/O Transfer will turn off.

In the Serial Request Timeout field define the amount of time you would like the E3
I/0 module to wait for a response from the before it moves to the next transfer in
the list. The minimum serial request timeout is 100ms and the maximum is
255000ms. Some devices take longer to respond than others, so this value may
have to be adjusted depending on the device. If a response is not received before
the Ethernet request timeout expires the status bit associated with the 1/O
Transfer will turn off.

REVISION 1.0 PAGE 15



COMMUNICATIONS

E3 I/O MODULE USER MANUAL

NETWORK

— Untitled File - E3-ME{20884 - Crimson 3.0 - UNREGISTERED COPY
File Edit ‘Wiew Go Link

€Ne] i = MY > N R = [ R == NR - N 4

X | System - Communications - Network

—
X

m Communications

= T Metwork
W sisnet UDR
T Madbus

=) R&-465 Comms Port

= Senices
P Watchdog/Heartbeat
i Web Server

Ethernet 1 | Ethernet 2 | Download | Options|

=N |Eel )

d-
UL S

ﬁ Devices

[P Address Assignment

Port Mode: IMamua\ Configuration

IP Address: 192,168,121
Subnet Mask: 255.255.255.0

?g Communications

«.Eﬁ 170 Channels

Security Manager

é%‘ Devices

To select a target device other than the E3-MIX20354, use the New command on the File menu.

ETHERNET 1 TAB

IP Address Assignment

MU

The Port Mode field is used to set the method by which the IP address will be

assigned. Each device on an Ethernet TCP/IP network has a unique IP address.
When in Auto-assign IP Address by Station Number mode, each Ethernet I/O
module is assigned an IP address by default, based upon the station number (0 to
15,999) that you assign to it. Depending upon the setup of your network, you
may or may not be able to use these addresses. An IP address can also be
assigned automatically via DHCP or it can be assigned Manually.

The IP Address field is used when assigning an IP address in Manual mode. The IP

Ethernet 1 IP address is used in both Passthru and Ring network modes for both
Ethernet ports. Default IP address is 192.168.1.21. Every E3 I/O module is
configured with this IP address from the factory.

The Subnet Mask setting determines whether a message should be routed to another

network. This field supports standard dot-decimal address notation (255.0.0.0).

The Default Gateway field is used to assign an IP address of a gateway (usually a

router or bridge) on the network. This feature allows your Ethernet I/O module
to communicate with devices on other networks. If you specify a TCP/IP
gateway address, then the TCP/IP gateway, if configured properly, will be able
to route messages to other networks on different subnets. Only one default
gateway can be configured in the E3 device at a time. If a default gateway
address is entered in both the Ethernet 1 and 2 tab there will be a conflict in the
modules routing table, and results may not be as expected.
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ETHERNET 2 TAB
IP Address Assignment

If the second Ethernet port is to be used, the Port Mode must be set as desired (see
above).

Refer to Ethernet 1 Tab above with regard to the IP Address, Subnet Mask and
Default Gateway fields. Ethernet 2 IP address is only used in two-network
configuration.

DOWNLOAD TAB

-2 Untitled - E3-MDX20884 - Crimsan 3.0 - UNREGISTERED COPY =N =R ==

File Edit Afiew Go  Link  Help
ENG TR = PN e NS NNz Sl TN M-
Iavigation Pane X| [sstem - communications - ResoucePane X

i X | Ethernet 1 | Ethemnet 2| Download | options | B Devices
ﬂ Communications
El 7§ Metwork

ET Sixnet UDR Selection Maode: [Manual v]

‘:T Modbus

=) R5-485 Comms Port Remote Lddress:
=] Services
P watthdog/Heartheat
ol Wb Server

Unit Addressing

9-{?‘ Communications

«s [}0 Channels

Security Manager {F‘!FI Devices

Unit Addressing

The Selection Mode field is used to determine how the IP address for database
download will be determined. Available modes are Manual, Auto Ethernet 1 and
Auto Ethernet 2. If one of the Auto modes is selected, the associated IP address
will be used.

The Remote Address field is used if Manual mode has been selected for entering an
IP address for database download.
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OPTIONS TAB

- Untitled - E3-MDC20884 - Crimson 3.0 - UNREGISTERED COPY

File Edit Wiew Go Link Help

ERe) i = W > e RS

B 5 F o Z

' X

B communications

= Ef Metwork
W Shnet UDR
v Maodbus

=) RS-485 Comms Port

= Setvices
P wiatchdog/Heartbeat
o8 Web Server

X | System - C ications -

Ethemet L | Ethemet 2 | Download | Options |

[=lle ks

-
UL )

5 Devices

Options

Dual Ethernet Mode: |Fu||uwjumper -

Advanced Options

Setreply message priority to incoming request priority [QOS)

Connection Timeout

Timeout Type: Zero Persistence b

0

4%' Communications

ﬁs /O Channels

Security Manager

Options

'ﬂl%l Devices

MUK

The Dual Ethernet Mode option may be used to prevent downloading configuration

to a module with an incompatible hardware configuration. When Follow Jumper
is selected, no check is done when downloading. When another value is selected,
the hardware jumper is checked before downloading configuration and the
download will not be allowed unless the jumper matches the option.

The Dual Ethernet Mode also sets or disables a self-check in the module depending

on the position of the Ethernet mode jumper under the configuration door of the
module. Select the module self-check option for the Network jumper that best
suits your application. Follow jumper mode will not display any error no matter
what position the network jumper is. When Ethernet pass-through mode is
selected the network jumper must be set for “pass-thru”. When force ring switch
mode is selected the network jumper must be set for “Ring-mode”. When Two-
Networks mode is selected the network jumper must be set for “2-nets”. If the
jumper settings do not match this configuration setting it will cause the device’s
Alert LED to flash with 2 ON Blips repeating to indicate a mismatching
configuration.

Follow jumper—When this option is selected the communications mode will
follow the state of the network mode hardware jumper on the I/O module.

Ethernet Pass-through—An unmanaged switch in the module passes Ethernet
traffic between the ports. This option allows /O modules to be daisy-chained
without the need for external switches.
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Force Ring Switch—This option allows the two Ethernet ports to act as Real-
Time Ring switch ports.

Two Networks—In this option, traffic is blocked between the two Ethernet ports
so that the I/O module can be connected to two independent networks. Each
Ethernet port will require its own IP address. See the Communications--
>Network-->Ethernet 2 tab to set the Ethernet 2 port address.

Advanced Options

Set reply message priority—In order to accommodate Quality of Service (QoS)
requirements, it may be necessary to set the reply messages to have the same
priority as incoming I/O requests. If so, check this box.

Connection Timeout

The Timeout Type field setting determines the amount of time that a TCP/IP session
can be inactive before it is eligible to be terminated by the Ethernet module. An
inactive TCP/IP session will be terminated only if the Ethernet module’s two
TCP/IP sessions are in use and a new TCP/IP session request has been received
from another Ethernet device.

The default timeout is zero seconds, meaning that the first TCP session that
becomes inactive will be terminated immediately if a new TCP session is
needed. If a time period is specified, then a TCP session will have to be inactive
for that period of time before it becomes eligible for termination.

The user can select any one of the following timer settings:

Zero Persistence
Infinite Persistence
User-defined

The Connection Timeout field is available when “User-defined” is selected as above.

SIXNET UDR PrROTOCOL — I/O TRANSFERS

—& Untitled File - E3-MIX24880 - Crimson 3.0 - UNREGISTERED COPY

File Edit View Go Link Help
Cacd e s e N & Pl s
m X | System - Communications - Network - Sixnet UDR

5 Communications
= " Network Add Additional Device

T Sixnet UDR

T Madbus

<) RS-485 Comms Port
= Services
P watchdog/Heartbeat

Port Commands

o8 Web Server

By default the E3 I/O module respond to Sixnet UDR and Modbus messages as a slave.
To use the E3 I/O Module as a Sixnet UDR or Modbus master configure slave devices
and I/O transfers under the protocol configuration.

Port Commands
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Add Additional Device is used to create the slave device parameters under the
protocol configuration.

& Urtitled - E3-MI<20864 - Crimson 3.0 - UNRESISTERED COPY =2 E=R===
File Edit Wiew Go Link Help
3 A :
Mavigation Pane X | System - C ications - - Sixnet UDR - DEV1 M
PL Mew + | : B Devices
5 Cammunications gptiens @ DEvL
[=] q{' Metwork Station Mumber: {m DEv2
s
El § SixnetLDR 1P Address: 0.0.0.0
= i DEW1
. Transferl TCP Port: 1594 =
B Transferz
=5 Modbus Device Commands
= Wl DEv2
& Transferl Add &nalog Transfer
Transfer2 Add Discrete Transfer
) R5-485 Comms Part
= Services
B wistchdogi/Heartbeat
B Wieb Server

‘ﬁ%‘ Communications

‘.Ea IO Channels

Security Manager ‘F.{F‘ Devices

Port Mumber 2, Device Mumber 1 MUM

Options
The Station Number field is used to enter the appropriate value for the above device.

This IP Address field is used to manually enter the address of the device with which
the E3 /O Module will communicate.

Device Commands

Select Add Analog Transfer to define the parameters of the read/write I/O transfer to
the selected slave device. With an analog transfer the E3 I/O module can read
analog values from or write analog values to a slave device.

Select Add Discrete Transfer to define the parameters of the read/write I/O transfer
to the selected slave device. With an discrete transfer the E3 I/O module can read
discrete values from or write discrete values to a slave device.
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-2 Untitled - E3-MD(20884 - Crimsan 3.0 - UNREGISTERED COPY (=2 =N ==
Eile Edit Wiew Go Link Help
@V TR N o W (N N S Y .
W X | System - Ci ications - Network - Sixnet UDR - DEV1 -... Et-ﬂul“ Bﬂﬂi ‘
1] X B Devices
B Communicstions options Ul DEVL
= Network Direction: | Device to E3 = 0 DEv2
= W Shnet UDR .
© @@ DEvL Block Size:
Transfer? Destination Register
S Modbus Tyoe: (o1 <) ddress [1 2]
= @@ DEv2
Transferl a s
Transfer? ource Register
RE-485 Comms Port Type: DL v mddress 1 2]
= Senices
P Watchdog/Heartheat e
ol Wb Server
Status Bit: [ Nane -
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5 o channels
Security Manager 4?%‘ Devices
Discrete Transter, of 4 MM

Options

The Direction field is used to set either “Device to E3” or “E3 to Device”
communications direction. Use “Device to E3” to read values from the remote
device and “E3 to Device to write values to the remote device.

With the Block Size field set the number of registers that will be read/written with the
defined transfer. In an Analog Transfer the block size will be the number of
analog integers transferred. In the Discrete Transfer the block size will be the
number of bits transferred.

Destination Register

The Type and Address number where data will be transferred to (in the I/O module
for a read, in the remote station for a write). NOTE: the types of the Source and
Destination must be the same size. That is, you cannot transfer between discrete
bits and analog registers.

Source Register

The Type and Address number where data will be transferred from (in the remote
station for a read, in the I/O module for a write).

Status Bit

When a Status Bit is assigned, it will be TRUE when the last attempt of this I/O
transfer succeeded and FALSE when that attempted timed out. The status bits
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are in the range DI49 to DI64. By monitoring the assigned bits from a SCADA
system, you can tell if the data in the module is current.

MoDBUS

Refer to Sixnet UDR above for configuration descriptions.

RS-485 COMMS PORT

- Untitled File - E3-8A020M - Crimson 3.0 - UNREGISTERED COPY == E=H==")
File  Edit iew Go Link Help
A
(NS TR 5 NS e R NEEN =Nt Z -
Nillﬂiilaﬂ Biﬂi ; System - Communications - RS-485... Port1 Bﬁaﬂlﬂ Eiﬂi K
! - x ) ) B Devices
Driver Selection @ DEV3
5 Communications p
= =6F' Metwark Protocal; IMndhus Master VJ * ﬂ gx;
= 5 sixnet UDR "
= M DEv1 Driver Settings
Transferl . =
Transter2 Pratocal Tyne: [Modbus Rt -
= ? Madbus Lead time; ms
= 0 DEv2
Transferl Lag time: 2 2| ms
Transfer2 )
= =) RS-485 Comms Port - Modbus Mast Gap time: ms
M DEV3
= Serices Port Settings
" watchdog/Heartheat —
o5 Web Senver Baud rate; 9600 A
Data bits: | Eight b4
Patity: Mone b
Stop bits: Onei'
Pass-Through
4 I 3 hessage Pass-through: | Disabled =
150
?&I Communications
ﬁs 0 Channels Port Commands
Add Additional Device
Security Manager {?5‘ Devices
Port Mumber 1 FUIR

Protocol—Select the protocol that the I/O module will send or respond to. The
choices are as follows:

Disabled—No protocol supported. Port is inactive.

Universal Master - The 1/0 module will act as a UDR master. Select the protocol
type below.

Modbus Master — The I/O module will act as a UDR master. Select the protocol
type below.

UDR Slave (Binary and ASCII)—The I/O module will act as a UDR slave and
accept requests in binary or ASCII mode.

Modbus RTU Slave— The 1/0 module will respond to Modbus RTU requests.

Modbus ASCII Slave— The 1/0 module will respond to Modbus ASCII requests.
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Protocol Type — When the protocol field is set to Modbus or Universal master the
selection is active. Select either Binary (RTU) or HEX (ASCII) mode.

Baud Rate—Select the baud rate to be used by the module for communication. The
valid choices are as follows:

150
300
600
1200
2400
4800
9600
14400
19200
38400
57600

Data bits—Set to match devices with which the E3 module will communicate.
Parity—Set to match devices with which the E3 module will communicate.

Stop bits—Set to match devices with which the E3 module will communicate.

PROTOCOL TIMING

The Lead time default value of 8 ms has been designed to work well with a majority
of RS-485 I/O products. This setting should only be modified if you are
connecting to an RS-485 device which is specified with a different lead time
requirement. The valid range is 8-10,000 ms.

The Lag time default value of 2 ms has been designed to work well with a majority
of RS-485 I/0O products. This setting should only be modified if you are
connecting to an RS-485 device which is specified with a different lag time
requirement. The valid range is 2-10,000 ms.

The Gap time setting affects Modbus RTU modes only. The gap time is the length of
time between incoming characters which signals the end of one message and the
start of another. The default is 4 ms.

For Modbus RTU protocol, enter a longer time only if other Modbus devices on
the RS-485 network require a longer character gap time (usually necessary
because the device cannot send characters continuously without gaps when the
device is performing processor intensive tasks).

With Pass-through mode, this setting is used to locate the end of a reply
message. Enter a minimum gap (in ms) that will be encountered at the end of a
reply message. Keeping this gap length to a minimum will result in the best
performance of the Pass-through mode.
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PASS-THROUGH

Serial Message mode passes command data, intended for other devices, from an
Ethernet port to a serial port. This feature allows an I/O module to function as an
Ethernet to RS-485 converter, often eliminating the need for a special
communication board in your computer.

The station number embedded in each message is used to determine if a message
will be passed through to the serial port, or if it will be processed locally. If the
station number in the message matches the local station number, the message is
processed. If the station number does not match, the message will be passed
through to the destination port.

Pass-Through is only available when the I/O module is configured to use a
master protocol on the RS-485 port. When used, the module cannot process
incoming messages from another master device on the network. Therefore is
usually best not use I/O Transfers and Pass-through at the same time.

The Timeout setting is issued when any of the master modes are selected. The default
timeout period is 150 ms.

When Pass-Through mode is enabled, the timeout period begins immediately
after the last character of the outgoing command has left the RS-485 port. The
complete reply from the slave device must be received before the timeout period
expires, or the reply will be discarded. A longer timeout period may be necessary
if telemetry equipment introduces communication delays.

The pass-through timeout is required so that the module can give up on a
particular message reply that is expected and move on to passing out the next
pass-through request. It is imperative that the pass-through timeout be kept as
short as possible because a communications failure with the device being passed
to will cause request messages to accumulate in the buffers and eventually
degrade the performance of all communications to all devices.

PorT COMMANDS

Add Additional Device is used to create subsequent devices to be configured. This is
only available with master devices.
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COMMUNICATIONS
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Port Number 1, Device Number

OPTIONS

The Station Number field is used to enter the appropriate value for the above device.

Device COMMANDS

See Sixnet UDR above for description of Device Command.

ADD ANALOG/DISCRETE TRANSFER

Add an Analog or Discrete Transfer to read or write information to another device on
the RS-485 network.

[Paaugation Bane X svstem - Communications - 5-45..

EJ e | X ) B Devices
B communications options @ pEv3
B Netwark Direction:  [Dewice to E3 T = E:;
= ¥ sixnet UDR =
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& @ oev Black Size
Transferl - )
Transferz Register
“Yao : IO
Type: (L v|  address [1
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Source Register

Transferl
Transfer2

[ <) R5-485 Comms Port - Universal Slav TEm sddress: (1 2]
) 0 DEv3
B Transferl .
Status Bit
= 8§ senices
@ Watchdog/Heartbeat Status Bit:
ol Web Server
4 m »

"analog Transfer, of

—

T e Tra T FEAD TRFT WO

See the Transfer settings in the Ethernet section above for the definition of Direction,
Block Size, Type, Address and Status bit.
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SERVICES

WATCHDOG / HEARTBEAT MONITOR
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WATCHDOG OUTPUT ACTIONS

The I/O module includes a dedicated microprocessor that continuously monitors several
user-selected system functions.

These watchdogs are combined on the same “Watchdog Output” to trip a failure alarm
(See the hardware installation manual for more information). The user can select for
activation any or all of the parameters below ("watchdogs"). When any one of the
selected actions trip the “Watchdog Output” on the module will drop.

POWER 1 FAILURE
The voltage on the Power 1 input is below the valid threshold or not present.

POWER 2 FAILURE

The voltage on the Power 2 input is below the valid threshold or not present.
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ETHERNET RING FAILURE

The Ethernet Ring is not complete. This selection is only used when the module set
for Ring mode.

WATCHDOG CPU MONITOR

The heartbeat from the main CPU is not present.

I/O PoLL TIMEOUT

When no traffic is detected on any communication port for the configured timeout.
I/0 Poll timeout feature must be enabled.

HEARTBEAT TIMEOUT

When the defined “Heartbeat Register Address” stops toggling for the specified
timeout.I/O Poll Timeout Settings

I/O PoLL TIMEOUT

If enabled, checks that an I/O request has not been received from an external source
on any port for the given I/O Poll Timeout period.

I/0 PoLL TIMEOUT ACTIONS

TIMEOUT

Specifies how many seconds the module will wait for a response to an I/O request
before considering the communication to have failed.

DROP PHYSICAL OUTPUTS

If this checkbox is selected, the module will zero its discrete or analog outputs until
communication is restored. If a discrete output is configured as time-
proportioned output (TPO) and the communication is lost, the analog output that
contains the TPO value will be set to zero. The TPO will continue to toggle for
the remainder of the TPO cycle time and then it will remain OFF until the
communication is restored.

If the checkbox is not checked, the outputs in this module will remain indefinitely in
their last known states until communication is restored. Each time proportioned
discrete output will continue to toggle, based upon its last known analog output
value.

DROP FIRST DISCRETE OUTPUT

Check this box to have the first physical discrete output in this module turn off (or
drop) upon a communication loss. Note that this output will normally remain ON
until a communication loss is detected.
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DROP VIRTUAL OUTPUTS

Check this box to have all internal analog or discrete outputs in this module turn off
(drop) upon a communication loss.

HEARTBEAT TIMEOUT SETTINGS

HEARTBEAT TIMEOUT

If enabled, and after the given Heartbeat Boot Delay period, checks whether a
heartbeat toggle has been received on the given Heartbeat Register within the
given Heartbeat Timeout period.

HEARTBEAT REGISTER TYPE

Select "DI" for monitoring a discrete input register, or select "DO" to monitor a
discrete output register.

HEARTBEAT REGISTER ADDRESS

This is the discrete input or output register (depending upon the previous selection)
to monitor for a heartbeat signal. This can be a physical or internal register. The
valid range is 1-512.

BooT DELAY

This is the number of seconds the module will wait after boot (power cycle) until
starting to monitor the heartbeat signal. Valid range is 0-32000. To determine the
best time to enter measure the average time it takes the device generating the
heartbeat to boot up and start toggling the heartbeat register. Once the boot delay
time elapses and no heartbeat signal was detected the outputs will drop and
remain unchangeable until the heartbeat signal is detected again.

TIMEOUT

This is the number of seconds the module will wait after the last heartbeat signal
before triggering the selected heartbeat events. For example, if this value is "3",
and if the checkbox for "Drop Physical Outputs" is checked, then if a heartbeat
signal has not been received within three seconds of the last one then all physical
outputs will be turned off (dropped). If the heartbeat signal resumes, then the
outputs will become changeable again, although they will not regain their
previous levels. Valid range is 0-65000

DROP PHYSICAL OUTPUTS

Check this box to have all physical discrete and analog outputs turned off (dropped)
if a heartbeat signal has not been received within the Heartbeat Timeout of the
previous one.
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DROP FIRST DISCRETE OUTPUT

Check this box to have the first discrete output turned off (dropped) if a heartbeat
signal has not been received within the Heartbeat Timeout of the previous one.
Note that this output will normally remain ON until a heartbeat loss is detected.

DROP VIRTUAL OUTPUTS

Check this box to have all internal discrete and analog outputs turned off (dropped) if
a heartbeat signal has not been received within the Heartbeat Timeout of the
previous one.

WEB SERVER
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OPTIONS

The Enable field allows you to enable or disable the web server in the I/O module.
Authorized users then have password access via a standard web browser to the
web server. Permissions for the users are set in the Security Manager category
accessible from the navigation pane.

Use the Port Number field to set the appropriate web server port. Default is HTTP
port 80. When a port other than 80 is used enter the port number the web
browser with a colon at the end of the module address. For example, if port 100
was selected access the E3 module’s web interface by entering 192.168.1.21:100
(IP address:Port number).
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I/0 CHANNELS
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The top level page of the /\O Channels section provides a summary of available NO
channels.
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I/O CHANNELS
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OPTIONS

Filtering Response

Select Fast Response (no filtering) for instantaneous input updates.

Use this mode for:
- DC inputs with scans less than 1 ms

- Counter applications with rates faster than 400 Hz

- When there is no contact bounce

Select Slow Response (more filtering) to enable filtering of the input signals to
eliminate contact bounce from mechanical contacts, ignore power dropouts and

ignore noise pulses.
Use this mode for:

- DC inputs with scans slower than 15 ms

- Count inputs from mechanical contacts (20 Hz)

Source/Sink Mode

REVISION 1.0
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Select the Source/Sink Mode that matches the jumper setting on the base of the
combination I/O module onboard inputs. The number of inputs affected by this
setting will vary by module type.

Follow Jumper—When this option is selected the mode will follow the state of the
hardware jumper on the I/O module. No matter what state the jumper is in the
Alert LED will not be triggered.

Source DI- (jumper to -) is the default factory setting, which is appropriate for most
situations in which a positive voltage is applied to an input to indicate an "ON"
condition. If the jumper is placed in a different position the module blink the
Alert LED 2 blips ON to indicate an invalid configuration.

Source DI+ (jumper to +) should be selected for "ON" inputs corresponding to
ground closures that require a positive reference as an opposing return
connection. If the jumper is placed in a different position the module blink the
Alert LED 2 blips ON to indicate an invalid configuration.

Counter Mode

With this mode enabled by selecting either Use 16-bit Counter or Use 32-bit
Counter, an analog input register corresponding to each discrete input will
increment with each OFF to ON transition of the corresponding input. The
maximum input rate for this feature is 100 Hz (6000 pulses/min). These counters
are reset by cycling power to the module.

When Use 16-bit Counter is selected, each counter is 16 bits and has a range of 0-
65,535. All discrete input channels are supported. When Use 32-bit Counter is
selected, each counter is 32 bits stored in two adjacent 16-bit registers and has a
range of 0-4,294,967,295. Each counter will take two registers, so half the
counters are reported in this mode. For example, an E3-16DI24-1 is set to enable
counters and set to Use 16-bit Counter. In this case the counter (analog input)
registers 1-16 are used to display the pulses counted on discrete input channels
1-16. If the E3-16DI124-1 was set to Use 32-bit Counter analog input channels 1-
16 would be used to count the pulses on discrete input channels 1-8 because
there are two registers per discrete input channel.

CHANNELS

DI1, DI2, DI3.../Feature

When Up Counter is selected the pulses on the DI channel will be counted in a
continuous up counter in the corresponding analog counter registers. The count
register may be read from the Analog counter registers defined in the Analog
Input section of the I/O Channel section.

Note that certain modules offer the option to enable High Speed Counters on the first
two or four channels. Check the channel to enable these modes. This special
mode functions in the same manner as the discrete input count feature for the
remaining inputs, except that the maximum count rate for the input can be 2 kHz
or 50kHz (Please see the installation manual for the specifications for your
module).
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Note: On the E3-MIX24880-1 and E3-32DI24-1 modules only, the first high
speed counter is connected to two isolated input screw terminals, CNT+ and
CNT-. If the high speed counting option is not selected, then the pulses are
counted from the ordinary discrete input screw terminal in the manner typical of
all other input channels. The E3-M1X24882-1, E3-MIX20884-1 and E316DI24-1
ore capable of high-speed counters. See the installation manual for more details.

DI1SCRETE OUTPUT CHANNELS
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DiISCRETE OUTPUT OPTIONS

Use last 8 discrete channels as outputs—The third group of eight discrete /O on
MIX modules has both input and output capabilities at the same time. Output
functionality for a given channel may be individually enabled from within the
Discrete Output Channels configuration window. For compatibility with 1/O
drivers that write I/O in fixed blocks, all eight DO (output) registers are always
assigned. Only outputs that are enabled may be turned ON. Other output values
will be masked in the I/O module.

OPTIONS

Enable Time Proportioned Outputs if you want the outputs to be controlled as time

proportioned outputs (TPO). The outputs will not function as TPOs until they are
enabled per channel.
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Configure a Cycle Time between 10ms and 10 minutes in ms. Specify a cycle time
for all enabled TPO outputs in the module. Each TPO output will pulse ON and
OFF once during each cycle period, unless a Minimum OFF/ON time (see

below) is specified.

Specity a Minimum OFF/ON time (shortest allowable ON or OFF pulse) if your
output devices are not capable of changing state within 1 / 32767 of the desired
cycle time. (Mechanical relays can be an example of such a device.) The range
for the minimum OFF/ON time is 10 mS to 10 minutes. All settings will
maintain the time proportion by waiting multiple cycle times, if needed, to turn

an output on or off.

CHANNELS

Three Modes are available for each discrete output channel: Disabled, Enabled and
TPO controlled by AO. The TPO control register addresses hard coded analog
input registers and are defined in the I/O Channel summary page. They either
start with the first analog output channel or they are the first registers after the

onboard analog output channels.

ANALOG INPUT CHANNELS
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ANALOG INPUT OPTIONS

Select the appropriate Integration (conversion) time for the analog inputs in this
module. Achieving the desired resolution often involves a trade-off between
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conversion speed and noise reduction. The user can chose one of five analog
input conversion speed options:

50-60Hz—Auto-rejection of both 50 and 60 Hz noise. Conversion time is less than
131 ms per channel.

50Hz (Best Filtering)—Rejection of 50 Hz noise. Conversion time less than 130 ms
per channel. Effective resolution in this mode is 16 bits.

60Hz (Best Filtering)—Rejection of 60 Hz noise. Conversion time is 110 ms per
channel. Effective resolution in this mode is 16 bits.

50Hz (Fast Filtering)—Conversion time as fast as possible with 21 ms per channel
and 50 Hz noise filtering. Effective resolution in this mode is 14 bits.

60Hz (Fast Filtering)—Conversion time as fast as possible with less than 21 ms per
channel and 60 Hz noise filtering. Effective resolution in this mode is 14 bits.

CHANNELS

Select the appropriate Range. Some modules offer only one option. Others have
multiple current or voltage selections.

Scale Beyond PV Points— Each of the first eight analog input registers provide a drop
down menu with the following selections:

Positive Only—The analog input signal will display a value ranging from 4 mA
to 20 mA. A low end 4mA reading displays a "0" value, and the upper end 20
mA displays a "32767" value. Any current reading from 0 mA to 4 mA is
displayed as a "0" value. (This is the industry-accepted standard.)

Negative Below 4 mA—This is the same as "Positive Only" (above) except that
instead of displaying a "0" value for any reading from 0 mA to 4 mA, the module
will display a range from a "-8192" value for 0 mA to a "0" value for 4 mA. This
is useful in applications where an analog sensor becomes faulty, is not outputting
enough current (i.e., due to a power loss, may require calibration, etc.) and the
user requires the module to provide values readings below 4 mA.

Disable—This input is rendered inactive. This is useful in certain applications
where it is desirable to shut off one or more analog inputs to allow all other
enabled analog inputs to scan at a slightly faster rate.

Resolution—The input speed on the first two channels can be set for either /6-bit
integrating or 10-bit high speed. Each of these settings will override the Analog
Input Integration setting on the Analog Options screen. The 10-bit resolution is
selected in applications where capturing analog sensor data faster is more
important than obtaining high resolution data.
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ANALOG OUTPUT CHANNELS
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CHANNELS

Range— E3-8A020M-1 and E3-16AI8AO-1 support the 4-20mA range only, so no
configuration is necessary. The analog output channels on the E3-MIX24882-1
support the 4-20mA and 0-20mA range. While the E3-MIX20884-1 supports the
4-20mA, 0-20mA and 0-5V ranges. Each analog output channel can be
configured to an available range setting. These are software selectable ranges.
The hardware is calibrated to the 4-20mA range, so it may be necessary to field
calibrate the 0-20mA and 0-5V ranges to get the published specified accuracy.

PAGE 36 http://www.redlion.net/e3



E3 I/O MoDULE

SECURITY MANAGER

SECURITY MANAGER
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Permission Changes—Use this field to enable or disable permission changes for the

web user interface login when disabled no user permissions can be set and the
web interface may be accessed without credentials.

REvisiON 1.0

PaGe 37



SECURITY MANAGER E3 I/O MODULE USER MANUAL

NoO LOGIN REQUIRED
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The “No Login Required” user is the default user credentials. To enable access to all
or some of the web user interface without login credentials enable the required
System Rights for the No Login Required user. To disable access to the web user
interface without login credentials uncheck all the System Rights for the No
Login Required user. No credentials are required for this user.

SYSTEM RIGHTS

View 1/O values: Permits the selected user to view raw I/O values in the "Read /0"
screen in real time. No modifications of any values are permitted.

Configure tags: The selected user can change the discrete and analog input and
output type for each I/O register.

Configure communications: Permits the selected user to change Ethernet
communications settings.

Modify I/0 values: Permits the selected user to access the "Full Access" screen in the
Watch Window section of the web Ul The user can modify all discrete and
analog inputs and outputs as well as counter values.

Configure users: Authorizes the selected user to create new users and their associated
permissions.

Calibrate analog inputs: Authorizes the selected user to perform field calibrations
on analog input values via the web user interface. Calibration is not required, but
in some cases where signal error introduced by field wiring field calibration can
reduce or eliminate the signal error.
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User1 (DEFAULT USER NAME)

Click the New User E button to add users. Change the user name as desired. This
should be used when prompted for a user name and password.
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SYSTEM RIGHTS

See No Login Required above for information on System Rights.

CREDENTIALS

Password—Use this field to end user-specific password.
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